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Meeting programme
Wednesday 27th April 2016
7:30 Monthly Meeting
• Welcome and News
• Nambia: Land of Sand - David Chilvers
• Preview - Unexpected features - Peter Fitchett
• Questions,Answers, and other bits
• Supper
Come along and share your passion
for Apple products. Learn about the
latest technology, and enhance your
skills. And meet with old and new
friends over supper.
Visitors welcome.

Submitting your article
Electronic submissions are preferred (to save wear and tear on my
fingers). Just choose whatever format suits and send it to:
editor@appleusers.co.nz
One page is roughly 450 words. Most articles are less than 4 pages, but
longer articles may be accepted if of particular interest or relevance.
Please ask in advance if you are planning a longer article.
Please write clearly; short sentences are recommended to help you do
this. Use a spell-checker. If you are quoting some other article, please
include an acknowledgement of your source.
Pictures can help explain your article, so by all means include one (or
more) if appropriate. The format is not important - jpeg, tiff and gif are
all fine but try to provide a high-quality image (300 dpi) if possible.
For screen-shots, you can use the built-in Apple functions: Apple-Shift-3
or Apple-Shift-4, or a utility such as Snapz Pro, available from:
http://www.macdownload.com.

Next Deadline: 12 May 2016
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Take Control eBooks
Adam and Tonya Engst

TAKE CONTROL OF Your Passwords, Second Edition
https://www.takecontrolbooks.com/passwords
Do you find juggling Web site usernames and passwords frustrating? We
sure do, thanks to having hundreds of accounts, accumulated over many
years. During that time, the recommendations for secure passwords have
changed significantly and both the likelihood of problems and the
liability of having accounts compromised have increased radically. It’s
maddening, and, honestly, kind of scary, especially given the seemingly
non-stop password thefts from large companies and the importance of
online banking. Let us be clear:
It is unsafe to use simple passwords, to reuse the same password on
multiple sites, or to rely on tricks like character substitutions or
keyboard patterns. If you do these things, you are at risk for having your
online accounts broken into.
In Joe Kissell’s just-released Take Control of Your Passwords, Second
Edition (only US$10.50 after the 30% MUG discount), you can find realworld advice on creating a highly secure password management strategy
that will protect you from bad guys of all stripes. Joe explains what
makes for a strong password and helps you start using a password
manager (along with his favourite, 1Password, he looks at a dozen
choices), work with oddball security questions like “what is your pet’s
favourite movie?”, and make sure that your passwords are always
available when needed. The 149-page book also looks at how to audit
your passwords to ensure you can’t be compromised by old, insecure
passwords, use two-step verification and two-factor authentication, and
deal with situations where a password manager can’t help.
Remember, friends don’t let friends use weak passwords!

TAKE CONTROL OF Apple TV, Second Edition
https://www.takecontrolbooks.com/apple-tv
Do you have a fourth-generation Apple TV? Considering getting one?
Either way, TidBITS Managing Editor, Josh Centers, is here to help you
learn the ins and outs of Apple’s living room device in his
comprehensive Take Control of Apple TV, Second Edition. Unless you’re
an A/V whiz, you’ll appreciate how the book’s step-by-step instructions
and illustrations teach you to set up the hardware, use AirPlay, watch
videos, listen to music and podcasts, look at your photos, and enjoy a
wide variety of independent apps.
Take Control of Apple TV, Second Edition also reveals all the ways you
can use the new Siri Remote (summarized on a handy, printable cheat
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sheet to help you remember!), explains everything you need to know
about tvOS (including the massive tvOS 9.2 update from a few weeks
ago), and provides activation URLs for 50 video apps (so you don’t have
to type them manually).
You’ll learn how to:
• Find out if an iOS app includes a free copy of its Apple TV version.
• Enter your password by speaking it, rather than “typing” it.
• Three ways to Rewind video with the Siri Remote.
• Put both the Apple TV and real TV to sleep with a single shortcut.
• Check the Siri Remote’s battery level and charge it.
• Display photos from iCloud Photo Library on the big screen.
• Turn your TV into an interactive atlas with a mapping app.
• Use Apple’s new Podcasts app to watch and listen to some of the most
compelling entertainment being produced today.
But the Apple TV isn’t just about entertainment. Thanks to AirPlay, it
makes a great device for giving presentations from a Mac, iPhone, or
iPad with Keynote. It’s the perfect accompaniment for a road warrior
heading into unfamiliar conference rooms. Josh gives all the details,
including a list of what you’ll need to handle any hardware you may
encounter.
Once you’ve mastered everything the Apple TV can do with help from
this 175- page book, you’ll be well on your way to cutting the cable cord
and its pricey monthly bill! And as a MUG member, you can get it for
30% off!
Thank you for your support of Take Control—you make it possible for
us to keep bringing you the detailed documentation that Apple no longer
provides.
cheers... -Adam and Tonya Engst, Take Control publishers
Contact Editor for the coupon for 30% discount.

Bill Atkinson
Those of you with (very) long memories may recall this name. Starting
with Apple Pascal on the Apple II, and Macpaint on the Lisa and first
Macs, Bill has stamped his mark in many products and is a true veteran
of Apple Software development. Bill was recently interviewed in an
hour-long technology program, but it ran over time, so has been
broadcast in 2 episodes - well worth the time to watch if you have even a
minimal interest in how thing have become how they are today ...
https://twit.tv/shows/triangulation/episodes/244 4th April
https://twit.tv/shows/triangulation/episodes/247 27th April
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iPhone Memory
Whoa! This unusual (and risk-free) hack can free up hundreds of
megabytes, or maybe even a couple gigabytes.
It seems like iPhone storage is always at a premium, especially if you
have an entry-level model with just 16GB (an economic necessity for
many an iPhone owner). It's the rare user who doesn't know the pain of
trying to download a new app or snap a few more photos and seeing the
dreaded "not enough storage" message.
You've probably heard all the usual "free up space" tips, but I'm willing
to bet you haven't heard this one. It's an honest-to-goodness magic trick,
one that may fill you with joy while simultaneously making you a little
mad at Apple.
Your iPhone doesn't need to be jailbroken, and this doesn't void your
warranty or involve any kind of risk. Try it, and see what happens. Here's
the drill:
Step 1: Tap the Settings app and then tap General > About to see how
much storage is available. Note that as the "before" number.
Step 2: Open the iTunes Store app, head to movies, and find any really
large title. "The Lord of the Rings: The Two Towers" is a good choice at
6.83GB. (You just need to find a movie that requires more space to
download than you have available on your phone.) Tap the Rent button
twice, keeping in mind you won't actually end up renting it (and therefore
won't be charged anything).
Step 3: Once you see the message that there's not enough space available
to download your rental, tap Settings. Then navigate back to General >
About and you should see a couple hundred megabytes' worth of
additional available storage -- possibly even more.
Step 4: Repeat the process! (That is, go back to the iTunes Store app and
try renting the movie again.) Each time, you should wind up with another
chunk of freed-up storage. Keep going until you either have too much
free space (meaning you'd actually be able to download the movie) or the
available space stops rising.
We are not sure why this works, but the best news of all: There doesn't
appear to be a downside to this. It's not like iOS is secretly wiping out
your photos or something.
(With my luck, the iPhone would free enough space that the movie would
now download, and I would be charged the rental!)
Now, how did anyone discover this? If I had just checked how much
memory I had available, I wouldn’t try to download a larger movie.
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Launchpad
So you have finally tried Launchpad ... If your experience was anything
like mine, you saw a page of application icons - a random selection of all
your apps, and in some random order.Then you notice a row of dots at
the foot of the page and realise that you have 12 pages of these icons!
How can this be an efficient or effective way to launch an app when you
want it? It will take an age to even find its icon!
No, the problem isn’t with you, but really with the application.
Launchpad is another slightly(!) neglected OS X feature that made
improvements initially, and then stalled, making it less than useful to
many people.
However, with Launchpad active, you can just start typing—you don’t
even need to move the cursor into the search field—and the app shows
matching items, which you can mouse or arrow through to select and
run.
Enter one letter, and you will see all applications with that letter as the
1st letter of any word in the applications name.
Enter a second letter and you see all applications that have any word
starting with those two letters, and also those that have consecutive
words in their name beginning with the letters entered.
However, you do need to know the name of the application that you
want.
Tip: You can drag icons around, and their new location will be
remembered.
Tip: You can create folders by dragging an icon onto another icon. Drag
an icon onto a folder to insert it into the folder. Click the folder icon to
access the contained icons. Click outside the folder to return to the outer
page.
Tip: after typing in the first letters of an app in Launchpad, you can drag
the icon downwards and it will land on the launchpad page that you
started on.
Tip: Put similar apps in folders and you don't need to sort again.
If you want to pursue using Launchpad, you might consider Launchpad
Manager, (http://launchpadmanager.com/home.php), software that
radically simplifies and extends Launchpad. A free version includes
several features, like drag-and-drop re-ordering, renaming icons and
groups within Launchpad, and removing items and groups from
Launchpad. For $8, you can load custom layouts, alphabetize apps, and
better manage multiple selections and grouping. The latest version is
compatible with Yosemite and El Capitan.
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Special offers
Peter Fitchett
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
Nisus Writer Pro
Nisus Writer feels like home with support for Mac OS X autosave,
document versioning, and iCloud. These tools are right wherever you
want them. Customize which palettes are seen and when. Assign any
keyboard shortcut to any menu. Add any menu to the toolbar. You’re in
control. Learn more at www.nisus.com/pro/.
The regular price for Nisus Writer Pro is $79.00 (US). The coupon code
gives Apple user group members 25% off, making the price $59.25 (US).
Get Nisus Writer Pro at: https://nisus.com/store/
This offer is valid through July 31, 2016
IGG Software’s Banktivity 5
Banktivity 5 (formerly iBank) personal finance manager offers
sophisticated reports, debt/loan management, a streamlined interface,
simple and reliable import from Quicken or MS Money, powerful
investment tracking, free private cloud sync to iOS devices, support for
bill pay and multiple currencies, innovative transaction templates,
integrated web downloads, intuitive checklist-style reconciliation, file
attachments of any type, and much more.
Regularly $59.99 (US), this exclusive 20% discount price of $48.00 (US)
for Apple user group members is available on purchases from IGG only.
Free 30-day trial downloads available. 90-day money-back guarantee.
To learn more or purchase: www.banktivity.com
This offer is valid through May 31, 2016.
Fantastical 2 for Mac
Fantastical 2 is an advanced calendar and reminder app with a beautiful,
all-new design for OS X Yosemite and El Capitan. The original
Fantastical was only a menu bar app, but has now been reinvented into a
full Mac application, without losing the prior benefits and convenience.
Powerful and innovative versions are also available for the iPhone, iPad,
and Apple Watch. Learn more at https://flexibits.com/fantastical.
This offer is valid through April 30, 2016.
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
For further specials, see our website.
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El Capitan
Disk Utility
El Capitan introduced a whole new version of Disk Utility that, while a
bit prettier, is not so feature-packed! However, it turns out most of the
‘missing’ features have either moved to other OS X components or been
hidden. For example, the ability to burn disc images to CD/DVD-R/RW
disks has been moved to Finder – just right click your .iso file and select

the Burn Disc Image option. To erase a CD-RW/DVD-RW disc, just
right-click the optical drive’s entry in Finder under the Devices heading,
and select the Erase Rewritable Disc option. One thing mourned by
many is the Repair Permissions feature. Apple says the new System
Integrity Protection (SIP) makes this redundant but we will see. It is still
possible to repair permissions in El Capitan. It’s just buried as a
command-line system tool. To access it, open Terminal, which you’ll
find in the Utilities folder within the Applications list, and then paste-in
the following:
sudo /usr/libexec/repair_packages --repair --standard-pkgs --volume /
You’ll need to type your password when prompted and then wait while
the command completes. If you’re lucky there’ll be no output, which
means everything is fine. Anything that’s incorrect will be reported and
then fixed automatically, as used to happen with the old permissions
repair tool.
The one major feature to disappear is how to work with Raid disks more later.

Finder – Copy Pathname
Control-click a file in Finder while you hold down the Option key. The
Copy command changes to Copy as
Pathname in the contextual menu. This
copies the path to the file into the
clipboard, and you can paste it into
Terminal or a text document. It's a
really handy tool for power users and
programmers; and if you want to build
an index of where some files are located.

Finder – Preview
The preview pane is boosted with the same trackpad/Magic Mouse
gestures you might use elsewhere, which can really help when viewing
pictures or media. For example, place the mouse cursor over the preview
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pane while viewing a picture and you can use the same pinch-expand
gesture as you might use in Preview. While playing a video you can cue
back and forth using the two-finger scroll gesture, just like you might in
QuickTime Player.

Finder – Rename
You can now rename files in Finder by Control-clicking them and
choosing Rename. It's still a lot quicker and easier to just select the file
and press the Return key, though.

Finder – Rename Multiple Files
Renaming multiple files can be a tedious process when doing so
manually, but Finder can make it easier to rename a batch of files at
once.
1. Select the files that you wish to rename.
2. Right click, and select Rename Items. This will open the Rename
Finder Items box.
3. You can use any of the dropdown boxes to establish renaming rules
however you would like, but I personally like using Format instead of
Add Text or Replace Text for the renaming style. This allows you to
give the batch of files an
entire new base name. Use the
Custom Format box to insert
the base name of the files.
The Name and Format
dropdown box lets you
choose how you wish to
differentiate the files. You can
do so by adding an index
number, counter or date.
The Where dropdown box lets
you choose where to add the
differentiator. You can choose
to do so after the name, or before the name. If you choose one of the
numerical values, you can also apply a starting number. I recommend
starting with 10 since the rename utility doesn’t let you pad a leading
zero for single digit numbers.
4. Once you are satisfied with your naming decision, click the Rename
button to enact the changes. If you don’t like how it turns out, you can
always use Command+Z to undo and try it again.

Mail – Tabs
It had to happen ... The Mail app now supports tabs, just like Safari and
Finder windows. Switch to Mail in Full Screen mode and press
Command-N to start a new message, press Command-N again and you'll
start another new message in a tabbed window. Click the tabs to switch
between the two text editing windows.
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Mail – Track Flights
OS X has become very good at recognising
things like addresses and parcel numbers –
just right-click and select the Look Up option,
or force touch if you have a compatible
trackpad. New to El Capitan is the ability to
recognise flight numbers too – just force press
on a flight number in an email, for example,
and a pop-up window will appear showing
details (including even a map!). If you lack a
trackpad then you might be able to right-click
instead and select the Look Up option from
the menu that appears ... sometimes.

Maps – Apple Pay
If you want to know if a shop or restaurant you’re about to visit accepts
Apple Pay you can use the Maps app to select it, then click the (i) icon
within the pop-up window to view its info. Beneath the address details
might be an Apple Pay symbol. (Don’t hold your breath in NZ.)

Menu Bar
To hide the menu bar, simply open System Preferences > General and
then click “Automatically hide and show the menu bar”. From then on

the menu bar will disappear when not in use, only appearing again when
you glide your mouse towards the top of the screen.

Notes – Audio Recording
The new Notes app has a lot of enhanced
text editing features. In amongst this you
might overlook the fact that it now
supports video and audio playback. Dragand-drop any file to Notes to attach that
media clip to the note.
This is particularly interesting because it's really easy in OS X to create
an audio recording using QuickTime. Open QuickTime Player and
choose File > New Audio recording. Record your audio memo and then
drag it to a note.
Of course, they could have just allowed dictation directly into Notes!

Notification Centre – Find My Friends
Open Notification Centre and click Edit. Next, click the green Add icon
next to Find My Friends. Now, whenever you open Notification Centre
you'll get a quick heads-up of where all your friends are.
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Safari – audio muting
Yo can mute the sound playing within a tab in Safari by clicking the
small speaker icon at the right of the tab, or the speaker icon at the right

of the URL field. Clicking again will unmute the audio. However, you
might also try these tricks:
• If you hold down the Alt key (Option on some keyboards) and click
the speaker icon for a current tab, the audio output of all OTHER
tabs will be instantly muted.
• Hold down the Ctrl key while clicking the speaker icon and you’ll be
shown a pop-out list of all tabs that are currently making noise.
Clicking any entry will switch you to that tab.

Safari – Block Ads
El Capitan features built-in content blocking. Put simply, this means you
can now use certain extensions to block ads or tracking technologies at a
more fundamental level than before, saving on CPU power and battery
life compared to previous ad-blocking efforts. Unfortunately, there’s no
way to identify which extensions use the new contenting blocking system
other than examining the home page of each and hoping the developers
mention it. If the extension is also available for iOS devices, or states it’s
only compatible with Safari version 9 and above, then that’s also a pretty
good indication.

Safari – Reader View
Reader mode turns a web page into little more than
pictures and paragraphs of text, stripping out
everything that’s not needed, such as adverts. It’s
activated by clicking the paragraph symbol alongside
the URL on web pages that are compatible (and only
those with decent amounts of text are, with Safari
automatically detecting in each case). You can now
change the colour of the background and the font used
for the text. To access the feature, first activate Reader
mode and then click the “aA” icon to the right of the
URL field. Then select from the pop-up window.

Safari – Pin Tabs
To pin a website to Safari’s tab bar, simply right click the tab and select
‘Pin Tab’ – it’s also worth noting that this can be done from the Window
menu, but right clicking is faster and easier. The website will then be
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permanently pinned to the tab menu,
regardless of if you close the app
completely. Once you’ve had enough
of the pin, simply right click the icon
and click Unpin tab to remove it from
the tabs bar.

Save – Rename Files and Folders
When saving a file
using the “expanded”
File > Save As dialog
box (i.e. after you’ve
clicked the little arrow
alongside the filename
so you can see your files
and folders), you can
right-click any file or
folder in order to
rename it without any
need to invoke Finder.
This is useful if you
want to use a filename
that’s in use. This feature is limited to list and Cover Flow views.

Spotlight – Dictation
Open System Preferences > Dictation and Speech and set Dictation to
On. Ensure that the Use Enhanced Dictation option is selected. Now
open Spotlight (Command-Space) and use the Dictation Shortcut
(double-tap Function on most Macs). You can speak your request directly
into Spotlight, just as you would with Siri.

Spotlight – Natural Language
Spotlight now runs your search through a Natural Language processor
enabling it to detect phrases. So you can say "photographs from last
week" or "emails from Kate with attachments" and Spotlight will deliver.
You no longer have to use keywords like author:lucy or kind:document.

Terminal
Here’s one for the geeks! When working at the command-line in
Terminal within El Capitan, you might notice grey square brackets
appear in the left and right margins alongside any command you type.
These are called marks, and let you quickly identify a command within
many screens of command output. In fact, you can scroll instantly back
to the previous mark – that is, to the previous command – by tapping
Cmd+Up on the keyboard, and scroll down again using Cmd+Down. You
can explore other options provided by marks using the Edit > Marks
menu.
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Recording an iPhone / iPad
How to present and record your iPhone or iPad on your Mac
Every now and then you may wish to display something from your
iPhone or iPad on your Mac. A quick method is available if you simply
have a lightning cable.
This process only takes a few steps:
1. Plug your phone into your Mac
2. Close all auto-opening programs like iTunes and Photos
3. Open QuickTime Player
4. Choose “New Movie Recording” from the File menu (or press
Option-Command-N)
5. Click the small down-arrow next to the recording button
6. Choose your iOS device from the menu that displays
When done, the movie recording window will expand to be 4x the size of
the iPhone’s screen, so you can then press Command-minus a couple of
times to reduce it to the size of your phone’s screen, if needed.
At this point you should see the phone’s display on your Mac, and can
log in and use it normally. Doing so will show everything from your
phone on your Mac’s display. If you use an app that is in landscape view,
the display’s aspect ratio should change to show the phone’s output in the
same view.

Choose the options menu next to the record button to change
the audio source and choose your phone as the video source.
Since this is a movie recording, you can click the record button to
capture what your screen is showing, but if you want audio from your
phone to also be recorded then be sure to choose your iOS device from
the same drop-down menu next to the record button. If you use your
Mac’s microphone then you can narrate what you are doing to your
recording, so this default setting may be preferred in some cases.
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Patents
Peter Fitchett
It is rather uncertain how much reviewing Apple’s patents tells us what
will happen in the future. Apple applies for thousands of patents every
year, and most seem to just sit on the shelf .. just in case!
A recent patent relating to using “Force Touch” with a Magic Mouse has
been spotted. Patents and mouses have had a long history: the one-button
mouse, the two-button mouse, the two-button with scroll-wheel mouse,
etc. You get the idea. I even thought of a 60-button mouse that you could
use without a keyboard, but didn’t patent it. The Magic Mouse
incorporated gestures from iOS, so it was only a matter of time before we
saw Force Touch added.
The Force Touch based Magic Mouse is engineered to deliver a
responsive, uniform click no matter where you press the surface. And
underneath, force sensors detect how much pressure you’re applying and
give you new ways to interact with your Mac. You’ll be able to use a
Force click to enable new capabilities, like quickly looking up the
definition of a word or previewing a file just by clicking and continuing
to press on the Magic Mouse surface. You’ll experience this through
haptic feedback — a tactile vibration from the mouse that adds the sense
of touch to what you see on the screen. These advanced capabilities work
in addition to all the intuitive Multi-Touch gestures Mac users love.
I’m sure with a little bit of refining of the detection of the force used, the
keyboard can still be replaced ... a light touch to the mouse for an ‘A’, a
slightly heavier touch for a ‘B’ ...through to a shoulder-wrenching thud
for a ‘Z’ ― it shouldn’t be a problem, should it?
Another interesting patent is for a
bent (or folded) camera lens system
to provide an ultra-compact
telephoto lens for mobile devices.
Light is channeled in through the
primary lens, bounced off of a
mirror, and redirected to the
secondary lens which focuses it on
the image sensor. Moving the
secondary lens up and down, even
by tiny increments that may amount
to fractions of a millimeter, would
achieve the telephoto results.
I’m sure that I saw a camera
about10 years ago that used a
similar system to provide a very
thin body (about 1 – 2 cm).
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Photos Extensions
One of the promised features of the Photos application is the ability to
load third-part extensions to add new capabilities. This feature has
arrived with El Capitan. Some of the first available from third-parties are:

Affinity Photo
Apple Design Award winning software, Affinity Photo is about to offer its
retouching tools within Photos on El Capitan. This powerful collection
includes dodge, burn, clone, patch, blemish, and red eye tools, frequency
separation capability, and more. (Developed by Affinity/Serif; $40. Free
trial available).

BeFunky Express
Developed specifically to exploit Photos Extensions on El Capitan,
BeFunky Express is free, so it's going to be a great way for Mac users to
experience them. It offers tools - auto fix, skin smoothing, highlight and
shadows adjustments, teeth whitening and eye brightening - to help
improve self-portraits, family photos, landscapes. (Developed by
BeFunky).

Intensify
Running the Intensify extension with Photos will boost the colors on your
photo and make more image details visible. Intensify uses proprietary
tools to enhance pro contrast, improve details and structure selectively
based on tonal range. It also offers Layers, a customizable brush you can
use for selective editing, a histogram and vignette mode. The software
provides over 60 presets covering a range of effects. (Developed by
MacPhun; free trial available.)

Noiseless
Digital images often carry a little image noise. You can reduce this in
Photos to some extent, but Noiseless improves what you can achieve. It
can also automatically identify and reduce noise, and provides a range of
additional tools to fine-tune details after noise has been reduced. The
developers recognize that lots of us use iPhones to grab snaps, so they've
created a special algorithm to fine tune images captured with Apple's
smartphones. (Developed by MacPhun)

Snapheal
Photos hosts its own healing and a clone & stamp tool, but sometimes
you'll need more sophisticated image improvements than you can get
using these. That's where Snapheal steps in with a number of additional
features, including the capacity to remove multiple objects and a wider
range of tools (brush, lasso) you can use to select image areas that need
healing. There's also a range of healing modes for different types of
images. (Developed by MacPhun.)
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Tonality
Black and white images are incredibly effective. Somehow people relate
to them, but getting the most from the images takes skill - and Tonality.
The software provides dozens of professional presets, 16-bit RAW
process- ing and powerful controls for clarity, structure, split toning and
more, That's alongside a huge host of effects, lens filters, textures and
frames and support for layers, selective editing and a histogram.
(Developed by MacPhun)
You can find more in the App Store, including:

Color Filters For Photos
Add a creative touch to all your pictures, using a huge variety of colour
filters and a brush to create colour splashes, and adjust exposure or
gamma of selected areas.

Edge Photos Extension
Hundreds of Edges and Borders available for Infinite Variations.

External Editors For Photos
External Editors For Photos adds an extension to the OS X Photos
application that allows you to edit your photos with any image editor on
your Mac.

HayPhoto
With HayPhoto on the mac you get 124 custom designed filters and
professional quality adjustments. You can also turn your photo into a
beautiful pencil sketch or a colour pencil sketch.

HighDR Photos Extension
HighDR Effects lets you create rich HDR effect images from a single
image. Also features selective color adjustment: change your overall hue,
saturation, lightness and photo color temperature.

Perspective Photos Extension
Easy to use and fast tool to straighten/de-skew photos or graphics.

PicShare for Picasa
Easily upload photos and videos directly to Picasa Web Albums.

Stamp Photos Extension
Watermark your photos directly from within Apple Photos.

Vintage Photos Extension
Easy and stunning; hundreds of effects to give a retro look to any photos.
Unfortunately, you will need to get your wallet out for most of these.
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Here Abouts
Peter Fitchett

Lifetimes
As part of the company’s new environmental push (in calculating the
greenhouse gas lifecycle), Apple has listed how long it expects its
products to last for their ‘first owners’ - four years for OS X and tvOS
devices and three years for iOS and watchOS devices. My main
computer, bought new, is now 6 years old, so I am obviously not doing
my part. Software support, of course, is considerably longer than these
periods.
After the ‘first owner’, there is the 2nd, 3rd, etc owners, but eventually
even Apple products must look for the plot in Heaven - or be dismantled
by Apple’s recovery program to be born again in another guise. We
recently saw a video of a robot, Liam, dismantling an iPhone for material
recycling. Last year, Apple recovered 27.8 million Kg of materials,
including 1000Kg of gold and 3000Kg of silver. Apple have kept 270
million Kg of equipment out of landfills since 1994.

Paranoid?
We are all somewhat cautious with what we download so that we avoid
viruses and other nasties. Some of us even run software to monitor what
intgernet paths are used by different software that may be trying to “call
home” (or somewhere else unexpected). Now there is a little program
that will monitor your microphone and camera, and let you know when
something starts using them ... just in case you-know-who is getting
curious. If you are interested, check out “Micro Snitch”, currently a steal
at just US$3.99.

Again!
Adobe has issued yet another ‘Emergency’ Flash Player security update
to thwart ransomware attacks (Windows and Mac). Are you really still
using Flash?

No Calculator
Have you noticed that the iPad does not include a calculator app from
Apple? (iPhone does!)
It is actually a funny story. When they were prototyping the iPad, they
ported the iOS calc over, but it was just stretched to fit the screen. It was
there all the way from the beginning of the prototypes and was just
assumed by everyone at Apple that it was going to be shipped that way.
A month before the release, Steve Jobs calls Scott Forstall into his office
and says to him, “Where is the new design for the calculator? This looks
awful” Scott said, “What new design? This is what we are shipping
with.” Steve said, “No, pull it we can’t ship that.”
It’s been such a low priority ever since, that it has never happened!
page 18 Applebyte

Swift
Apple’s new programming language has been a big hit everywhere,
especially since it was released as open-source. Word has leaked out that
Facebook and Uber are looking to make Swift more central to their
operations,and even Google is considering making Swift a ‘first class’
language for Android. Google’s Android operating system currently
supports Java as its first-class language. While the ongoing litigation
with Oracle (about Java) is a likely cause for concern, sources say
Google considers Swift to have a broader ‘upside’. (I guess less court
cases is an ‘upside’.)

Airplane Mode
Airline passengers are repeatedly told to switch their mobile phones to
flight mode – but what happens if they don’t? Well nothing really. There
is no evidence signals from passengers’ electronic devices have ever
caused a plane to malfunction and crash, and experts said modern
technology is safe and reliable. If anything, a mobile that hasn’t been
switched to flight mode may just annoy pilots and air traffic controllers
with an unpleasant sound - like a bit of static.
On any given flight, multiple people with iOS and other devices never
turn them off (likely, some of these people don’t even know how to
really turn their iOS devices off) or never even put them to sleep. They
certainly don’t put them into “Airplane Mode,” either. Their Wi-Fi is on
all flight long and most of the time there are at least three personal
hotspots bouncing all throughout the plane, too. The fact is – we see it
almost every flight – some people simply hide them from the flight
attendants and continue to use them during takeoff and/or landing and,
guess what, we’re still here, and the plane is still flying safely.
Well that is all for this month;I hope that you have had a good read, and
if you are flying somewhere, make sure you put your phone into ;flight
mode’ - you don’t want to be the first to cause a problem!

SeniorNet Mac
Computer Training Lessons: Two-hour sessions, once a week for four
weeks. Course notes are provided. Classes are small with a maximum of
six students and two tutors per lesson.
Social Events: Held on the fourth Tuesday of the month.
Newsletter: Supplied every two months.
We are now located at: 190 Worcester Str, Christchurch.
Contact: If you would like to join SeniorNet Mac and are in the 55-plus
age group, please contact Allan Rutherford at (03) 352-4950, or email:
ajmr@xtra.co.nz,
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About the user group
Aims

Canterbury Apple Users is a non-profit
subsection of SeniorNet Mac
(Christchurch) that exists for the purpose
of exchanging ideas and expertise about
the use of Apple computers, the Macintosh
operating systems, and related hardware
and software.

Meeting venue
Meetings are held on the last
Wednesday of each month
(except December) beginning at
7:30pm, at the Convention
Centre, corner Highsted and
Sawyers Arms Roads.
Drinks, and maybe a snack, are
available while we all calm
down after the excitement of the
meeting.
If you find it difficult to get to
meetings, please contact an
organizer to see how we can
help.

Group contacts
Website

http://www.appleusers.co.nz

Mailing Lists

Peter Fitchett
listadmin@appleusers.co.nz

(3) 960 8189

The HELP email list is open to all Mac users who
wish to give or receive assistance. See our website
for instruction on how to subscribe/unsubscribe.

